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In this section:

■■ No computerese!

■■ The path of least resistance

■■ A quick overview

■■ A few assumptions

■■ What’s new in OneNote 2013

■■ Adapting task procedures for 
touchscreens

■■ A final word

About this book 1
M icrosoft OneNote 2013 Plain & Simple is for users of Microsoft 

OneNote 2013 who want to make the most of the program and learn 
how to do tasks quickly. Don’t look in this book to find out how OneNote 
2013 works. Instead, look in this book to find out how you can get your 
work done faster and better by using OneNote.

You can use this book as a tutorial or a reference. Read it one section at 
a time to become an expert on OneNote or keep it by your computer to 
refer to it when you need help. This book was written and designed so 
that you can get the information you need and complete tasks right away.



No computerese!
This book scrupulously avoids computerese, computerspeak, 
and nerd-talk. You will not scratch your head or grimace over 
computer jargon as you read this book.

For each task, you get a quick overview and the background 
information you need to proceed wisely. Then, you plunge 
right in. You get concise, step-by-step instructions for com-
pleting the task. And each set of instructions is accompanied 

by screenshots that show you precisely how to do the task 
and where to do it in OneNote.

Occasionally, you encounter a “See Also” element that refers 
you to a task similar to the one being described. You also find 
“Tips” that offer shortcuts and other useful advice. When you 
need to tread softly or carefully, you find a “Caution” element 
explaining why caution is the order of the day.
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The path of least resistance
More often than not, you can accomplish the same task in 
OneNote 2013 by using different methods. For example, you 
can create a table with the Insert Table dialog box or the 
Table drop-down menu.

Because there aren’t enough pages in this book to cover all 
the ways to complete each task, I sometimes cover the easiest 
way only. In this book, if I can’t be comprehensive and describe 
every technique, I choose the path of least resistance—the 
one that is easiest for you to follow.

1: About this book
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A quick overview
This book is your guide to getting the most from OneNote. 
It’s jam-packed with how-to’s, advice, shortcuts, and tips. 
Here is a bare outline of what you’ll find:

Sections 2 and 3 get you up and running. They explain the 
basics of creating, opening, and navigating notebooks. They 
also show you how to create the sections, section groups, 
pages, and page groups you need to organize and store 
notes.

Section 4 explains the nitty-gritty of OneNote: how to write 
a note; format, move, and copy text; and create bulleted and 
numbered lists.

Section 5 describes advanced note-taking, including how to 
write outlines, insert pictures and screen clippings in notes, 
attach a file and file printout to a note, write math equations, 
and take audio and video notes. You also find out how to jot 
down a quick note and place it later on into a notebook.

Section 6 explains all you need to know about formatting 
and laying out tables, including how to create an Excel 
spreadsheet in a note and how to convert a OneNote table 
into an Excel spreadsheet.

Section 7 is all about linking. It explores how to create links 
between different notebooks, sections, and pages; how to 
hyperlink to webpages and files; and how to take linked 
notes.

Section 8 describes all the things that you can do to make 
working with OneNote easier, including how to minimize the 

ribbon, Notebooks pane, and page tabs; how to dock One-
Note; and how to change screen views.

Section 9 takes on the spelling checker, including how to 
check the spelling of foreign text. Section 10 explains how to 
draw notes with lines, free-form lines, and shapes. Section 11 
describes tagging and other ways to organize notes, such as 
moving and copying. Section 12 explores how to search for 
stray notes.

Section 13 explains housecleaning chores, including how to 
delete and restore sections and pages and how to back up a 
notebook. Section 14 shows how to use the Research pane to 
investigate topics and translate foreign-language text.

Section 15 looks at distributing notes by printing them as 
well as sending them by email, and how to save OneNote 
pages, sections, and notebooks in alternate file formats. Sec-
tion 16 explores how to use OneNote and Microsoft Outlook 
2013 to handle tasks, calendar events, meetings, and contact 
information.

Section 17 describes how to share notebooks and how to 
find and read notes written by your coauthors. Section 18 
explains how to customize the ribbon and the Quick Access 
Toolbar to make yourself a more efficient user of OneNote.

Section 19 delves into OneNote Web App, the online ver-
sion of OneNote, and how you can use it to collaborate with 
others when taking notes.
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A few assumptions
Pardon me, but I made a few assumptions about you, the 
reader of this book.

I assumed that you are experienced enough with computers 
to know the basics: how to turn the thing on and what “click” 

and “double-click” mean, for example. I assumed that  
Microsoft Office 2013 (OneNote is part of the Office 2013 
suite) is already installed on your computer.

CAUTION  This book also assumes that you are using 
OneNote 2013, which is part of Office 2013. There is another 

version of OneNote, OneNote App for Windows 8, which is available 
through the Windows Store. This version is optimized for touch-
enabled devices, and it looks very different from the one described 
in this book. Although you can perform most of the tasks in this 
book by using OneNote App for Windows 8, the steps are slightly 
different. To learn more about OneNote App for Windows 8, see the 
book, Microsoft Office Professional 2013 for Touch Devices, by 
Katherine Murray.
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Starting OneNote in Windows 8
If your computer runs Windows 8, the procedure for starting OneNote 
is probably new to you. To start OneNote, click the OneNote 2013 tile 
on the Apps screen. The application opens on the Windows desktop.

Follow these steps to start OneNote from the Apps screen:

1	 Right-click the Start screen to display the Windows taskbar.

2	 Click All Apps.

(continued on next page)

What’s new in OneNote 2013
With each edition of OneNote, the makers of the application 
endeavor to improve it and add new features. OneNote 2013 is 

no different. Following is a rundown of new features in OneNote 
2013.

2

1
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Starting OneNote in Windows 8  (continued)

3	 Scroll to the right side of the Apps screen.

4	 Click the OneNote 2013 tile.

3

4

CAUTION  You might have installed another version of 
OneNote from the Windows Store—OneNote App for Windows 

8. If so, it appears in the Apps list as simply OneNote. The version of 
OneNote described in this book appears grouped together with the 
other Microsoft Office 2013 apps tiles, with the name OneNote 2013. 
Make sure you click the OneNote 2013 tile to start the program.
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Starting OneNote in Windows 7
If your computer runs Windows 7, follow these steps to start OneNote:

1	 Click the Start button.

2	 Click All Programs.

3	 Click Microsoft Office 2013.

4	 Click OneNote 2013.

1 2

4

3
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Navigating the Backstage view
To visit the Backstage view, on the ribbon, click the File tab. 
The Backstage view offers commands for creating, opening, 
printing, sharing, exporting, and sending OneNote note-
books. Click a tab on the left side of the Backstage view 
window and you see options on the right for performing 
different tasks. For example, click Info and you see informa-
tion about the currently open notebook.

What is different about the Backstage view in OneNote 
2013 is this: it now offers a convenient Back button. You can 
click this button to return to the OneNote screen.

Clicking the Options tab opens the OneNote Options dialog 
box, in which you choose settings to make OneNote work 
your way.

Click the Back button to return to the OneNote screen

1: About this book
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Sharing notebooks
OneNote 2013 is optimized for sharing notebooks through SkyDrive. 
SkyDrive is an online cloud service from Microsoft for storing and 
sharing files. To use SkyDrive, you must sign up for a Microsoft 
Account. After signing up, you can store OneNote notebooks on 
SkyDrive so that you can access them from anywhere—through 
OneNote, OneNote Mobile, or a web browser (using OneNote Web 
App). You can also share notebooks stored on SkyDrive with your 
friends and colleagues when you need to work collaboratively.

You can also share notebooks through a SharePoint site, a company 
network, or Microsoft Office 365 (which provides a SharePoint site 
or SkyDrive for file collaboration). SharePoint is used by companies 
to share files. It provides a structured method for collaboration 
through blogs, wikis, and company news updates. To share 
notebooks through SharePoint, save the notebook to a folder 
on the SharePoint site. To share notebooks through a company 
network, save the notebook in a shared folder.

Office 365 is a subscription service that provides online storage 
of notebooks and other services. Depending on your subscription 
level, you can share notebooks through SkyDrive or through a 
SharePoint team site designed for collaboration.

 SEE ALSO  To learn how to create and share notebooks on 
Office 365, read “Creating a notebook in Office 365” on page 260.

SEE ALSO  To learn how to share notebooks through SkyDrive 
or SharePoint, read “Sharing a notebook” on page 226.

TIP  You can sign up for a Microsoft Account at https://signup.
live.com. After creating an account, you can log on to SkyDrive 

and access your files and OneNote Web App at www.skydrive.com.

1: About this book

10  Sharing notebooks

https://signup.live.com
https://signup.live.com


Using the Send To OneNote tool
The Send To OneNote tool opens in its own window when 
you start OneNote. It offers a convenient way to access three 
OneNote commands:

■■ Screen Clipping  Click Screen Clipping in the window 
to capture part of an open window on your computer 
screen as a screenshot. (You can also take a screen clip-
ping on the Insert tab by clicking the Screen Clipping 
button.)

■■ Send To OneNote  Click Send To OneNote to copy 
a Microsoft Word document, Microsoft Excel spread-
sheet, or Microsoft PowerPoint presentation to a page 
in a notebook. Before clicking Send To OneNote, open 
the document, spreadsheet, or presentation.

■■ New Quick Note  Click New Quick Note in the 
window to write a quick note—a note that you can 
move later to a page. Quick Notes are stored tempo-
rarily in the Quick Notes folder until you move them 
elsewhere.

Take a screen 
clipping

Send a file to 
OneNote

Write a quick 
note

SEE ALSO  To learn all the details of writing quick notes, 
read “Writing quick notes” on page 76.

SEE ALSO  To learn the details of sending files to OneNote 
with the Send To OneNote command, read “Sending files to 

OneNote” on page 86.

SEE ALSO  To learn all the details of taking screen clippings, 
read “Taking a screen clipping” on page 92.

TIP  You can also open the Send To OneNote window by 
clicking the Send To OneNote Tool icon in the notification area.

TIP  If you prefer the Send To OneNote Tool not to appear 
when you start OneNote, clear the Start With OneNote check 

box located at the bottom of the Send To OneNote window.
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Updating your Office account
Office is available in two basic versions: Office 2013 and Office 
365. Office 2013 is standard “boxed” software. It comes in different 
editions—Office Home and Student or Office Home and Busi-
ness—that might or might not include Microsoft Outlook, Microsoft 
Publisher, and Microsoft Access.

Office 365, on the other hand, is a subscription service that pro-
vides various services (depending on your subscription level), such 
as cloud storage, email, shared calendars, instant messaging, online 
editing of Office documents (using Office Web App and/or stream-
ing versions of the full programs—Office on Demand), public 
website, and a team site for document collaboration.

If you subscribe to Office 365 Home Premium or an Office 365 
service that supplies Office, OneNote and your other Office pro-
grams are updated automatically during your subscription period. 

If you purchase Office 2013 as a classic software package, without 
the subscription and without the services, you will receive updates 
during the entire product cycle (approximately two years or so), as 
well. These updates will also install automatically, provided you’ve 
instructed Windows to do that. Display the Windows desktop by 
clicking the Desktop tile on the Start screen. Move the mouse 
pointer to the lower-right corner of the screen and click the Settings 
charm. Click Control Panel, click Systems And Security, click Windows 
Update, and then click Change Settings. In the Change Settings 
dialog box that opens, select the Give Me Updates For Other Micro-
soft Products When I Update Windows check box and click OK.

In the Account window in OneNote, you can view the list of services to 
which you are connected—SkyDrive, Office 365 SharePoint site, and 
others. To open the Account window, click File to display the Backstage 
view and then click the Account tab.

By clicking the About OneNote button in the Account window, you 
can open a dialog box that displays your Product ID number.

1: About this book

12  Updating your Office account



Sorting table data
Sorting means to rearrange the information in a list or table 
in alphabetical or numerical order. In a table of names, for 
example, sorting the list in alphabetical order from A to Z 
makes finding a name easier. In a table of numbers, sorting 
the table in numerical order makes comparing the numbers 
easier.

With the Sort command, you can sort a table in ascending or 
descending order and make your table easier to understand.

Click the Sort button to sort table data

SEE ALSO  To learn the ins and outs of sorting information 
in a table, read “Sorting data in a table” on page 105.
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